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PREFACE 

This is truly an amazing time.  When the Diabetes Electronic Management System (DEMS) came 

out early in 1999, there were very limited alternatives.  DEMS evolved into a more flexible 

registry for defining and tracking measures for other chronic conditions and today CDEMS is 

used extensively nationwide.  In 2007, over 130 clinics in Washington State currently use 

CDEMS and I‟ve heard from CDEMS users in at least 35 other states! 

 

Clinics are actually data warehouses.  Data is everywhere... patient contact information, medical 

histories, outstanding referrals, pending laboratory results, scheduled upcoming visits.  We are 

awash in facts and results and calendar entries, often without the tools to manage and retrieve 

what we need.  Research has actually measured, quantified and reported the extent of the 

problem.  The results are in: 80% of the time providers don‟t have available all the information 

that they need during a patient visit to provide care! 

 

If you work with patients and have unmet data management needs, CDEMS might help.  

CDEMS is free, the result of the generous sharing of many individuals and agencies.  Like 

hundreds of clinics before you, I hope you discover the power of the registry to improve 

healthcare and find CDEMS useful, easy to install, and valuable in the care of your patients with 

chronic conditions. 

   

This User Guide introduces you to CDEMS and assists with installation, setup and use of the 

registry at your clinic.  The author, of course, is solely responsible for all errors or omissions in 

this manual.  You can become an active part of the CDEMS network working together to 

improve care.  Please let me know when you come across something that can be improved in the 

program or documentation by sending a message to jackie@cdems.com.  The current registry 

efforts have been built with user contributions and mutual support among users like you 

dedicated to improving patient care! 
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INTRODUCTION TO CDEMS 

What is CDEMS? 

CDEMS is the Chronic Disease Electronic Management System, an 

electronic registry developed by the Washington State Diabetes Prevention 

and Control Program.  Evolving from the original Diabetes Electronic 

Management System (DEMS), CDEMS was first released in 2002. 

CDEMS is a Microsoft AccessÑ database application designed to assist 

medical providers and management in tracking the care of patients with chronic health 

conditions.  A paper-based system, CDEMS is designed around a progress note that facilitates 

standardization of care for patients with a particular chronic condition.  Printed progress notes, 

patient lists, and summary reports generated from the registry database have altered the way 

services are delivered and measured for clinics nationwide. 

 

Customizable measures for related health conditions, medications, services and labs may be 

defined by the CDEMS user for any chronic health condition. The progress note summarizes 

current status of a patient‟s care for each measure tracked for a chronic condition and serves as a 

convenient checklist for the provider during a visit.  Ticklers can be defined for early alerts of 

services and labs that are due or out of the target range.  A graphs page shows patient trends for 

weight and blood pressure and key labs over the past two years.  Measurements guide the 

management of individual patients and monitor quality of care for the population with by a 

chronic condition. 

 

Flexible reporting tools generate statistical summary reports and intervention lists showing who 

has received care and who has not.  Simple reports templates facilitate creation of user-defined 

reports based on each clinic‟s unique measurement set for a chronic condition.  Pre-coded reports 

and queries are available as well as full capability of Microsoft Access query writing tools.  

Changes can be monitored over time for a patient population with a chronic condition 

documenting progress for quality initiatives and pay-for-performance measures. 

 

Optional modules are available for electronically posting lab results into CDEMS and for 

aggregate reporting from multiple sites. 

 

Technical requirements are minimal.   The minimum hardware requirement to implement 

CDEMS is a single PC for data entry and a printer (preferably color) to produce the progress 

note.  CDEMS can be installed on a single PC or networked on a shared server across multiple 

workstations, or installed on a SQL server.  Microsoft AccessÑ is required to run CDEMS.  

CDEMS program files for use with Access-97, 2k versions prior to 2007, Access-07 and a SQL 

version are available from the CDEMS website at www.cdems.com. 

 

http://www.cdems.com/
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The registry is organized into three basic program modules: 

  

1. Data Entry program (cdem_DataEntry_10-12-09.mdb) – supports data entry, data 

editing, viewing and printing the Progress note 

2. Reports program (rpts_6-26-097.mdb) – produces intervention, summary and user-

defined reports and allows users to create custom queries  

3. Data storage file (cdem_dta.mdb) – stores individual patient health data and clinic setup 

tables 

 

and three additional optional modules: 

 

4. Electronic Lab Interface program – optional lab interface programs available for PAML, 

QUEST, LabCorp/ Dynacare, PacLab and Dynacore electronic downloads.  

5. PowerTools program (PowerTools_4-22-05) – two CDEMS PowerTools perform 

advanced special functions in CDEMS.  “Grouper” enables data file aggregation for 

multi-site reporting; “Logger” displays a list of current data file users, useful for security 

and maintenance of the CDEMS data file. 

6. Import programs – conversion tools are available for CVDEMS and PECS users wishing 

to convert to CDEMS.  These programs transfer CVDEMS and PECS data into the 

current CDEMS data file.  Contact jackie@cdems to obtain these tools. 

 

CDEMS Quality Improvement Role 

CDEMS improves patient care by addressing four key elements of the Chronic Care Model
1
:  

 

¶ Delivery System Design.  The core function of CDEMS is the creation of the Progress 

Note for use by providers during clinic visits.  These summary sheets consolidate 

information typically scattered throughout several sections within a chart.  Making this 

summary of the current state of care readily available radically transforms the office 

visit.  During the patient visit, the provider easily updates the patient information directly 

on the Progress Note by using checkboxes and text entry.  After the visit, a copy of the 

updated Progress Note is sent to data entry where new information is entered into the 

database.  The Progress Note also serves as a checklist for the health care team guiding a 

more standardized approach to chronic health care. 

 

¶ Decision support.  The CDEMS Progress Note displays patient information in four 

distinct sections: Conditions, Medications, Services, and Laboratory.  The items 

displayed are controlled by entries in the 'setup' table.  These customizable entries can be 

based on clinical guidelines and serve as ticklers for providers during patient visits. 

 

¶ Self-Management.  The Progress Note has an optional graphs page that displays 

historical trends over the past 24 months.  Graphs show visual pictures of where the 

patient is in their care and can include recommendations.  Used as a handout, this page 

helps to educate patients and promote self-management. 

 

                                                      
1
 Chronic Care Model the cornerstone of the collaborative work now growing across the country.  

Originating from work done by Ed Wagner et. al. of ICIC, and Don Berwick of IHI. 

mailto:jackie@cdems
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¶ Registry.  The information used to compile the Progress Note comes from an underlying 

Access database.  Through the Reports program, CDEMS can generate lists of patients 

who are overdue for a visit, lab or other specialty service.  These patients may then be 

contacted by phone or automatically notified by letter or postcard.  Reports also aid in 

the development of strategies to use clinic resources most effectively.  By generating 

clinic-wide reports about patient characteristics and services provided, a clinic can alter 

the way services are delivered and measure progress in meeting quality improvement 

goals.  Population-base registry reports can provide documentation of care for National 

Committee For Quality Assurance (NCQA) certification or for pay-for-performance 

reimbursements. 

 

Keys to Success 

CDEMS can dramatically transform how care is provided.  Below are a 

few initial points to keep in mind for a successful implementation: 

 

 Start slow.  Staff members often report they enjoy their work more and do their jobs 

better.  While your first inclination may be to have everyone in your clinic use CDEMS 

immediately, it‟s better to select one or two providers who have a keen interest in doing 

this work.  Create a team around these providers.  Identify, train and commit support 

staff to enter data, print new Progress Notes, and produce periodic reports.  Ideally 

standing orders will be created so that support staff can independently order services and 

labs when they are indicated. 

 

 Involve others.  Share your experiences and successes with other staff members as you 

implement CDEMS.  Sharing what is happening builds cooperation when you need help 

or later when your registry expands to more patients or conditions.  Sharing the reports 

about patient outcomes is especially powerful.  Also, allowing others to be involved in 

making decisions about the scope and design of CDEMS encourages them to support the 

project as their own. 

 

 Use CDEMS for its designed purpose.  CDEMS is a tool ideal for managing long-term 

chronic conditions.  It prompts providers about the state of conditions that need continual 

monitoring and prompts for tests that reoccur on a schedule.  CDEMS is not a full-

fledged electronic medical record (EMR).  Users who attempt to track medication levels, 

extensive history, and risk factors will be overwhelmed with data entry and complexity. 
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CDEMS Technical Requirements  

Listed below are the essential requirements for CDEMS: 

 

 PC with a Pentium 200 MHz or higher processor 

 7 MB of hard-drive space for installing basic program files + 

room to grow a registry 

 Microsoft Windows 98 or later operating system or Microsoft Windows NT Workstation 

operating system 

 Microsoft Access 97 or later installed with all available options (not a laptop install) 

 Internet access for program downloads 

 e-mail is desirable, but not an absolute requirement 

 A printer (color recommended) to print CDEMS Progress Notes and reports 

 A CDEMS coordinator to oversee the entry of new patients into CDEMS and to update 

patient data 

 Administrative support.  CDEMS is a system that impacts providers, medical records, 

and nursing staff.  Senior leadership support and widespread staff support are essential to 

make this effort successful. 

Getting Started Checklist 

 Read through this User Guide carefully and obtain administrative support to try CDEMS at 

your site.  Select a coordinator and back-up coordinator who will be the liaison for CDEMS 

questions and maintenance. 

 

 Identify a PCP or two who will pilot CDEMS at your clinic. One or two PCP‟s with a 
starting registry of 50-100 patients works well.  If you have an Information Systems leader at 

your clinic, brief them about CDEMS and assure them that CDEMS is freestanding and does 

not require changes in existing computer systems. It can, however, be integrated into the 

clinic management system once its usefulness has been proven. 

 

 Identify and create a plan for how CDEMS will be backed up (weekly on a zip drive, LAN 

file, or CD is recommended).  

 

 Obtain a confidentiality release with non-clinic tech support staff, so they can provide 

assistance in troubleshooting any difficulties using patient information stored in CDEMS.  

Meet with the PCP champions and other interested people at your clinic to collaborate on 

how CDEMS will be used. 
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INSTALLATION & SETUP  

CDEMS files are available at www.cdems.com on the Internet.  The installation instructions 

below are for the Internet download of CDEMS files.  However, for those without Internet 

access, the CDEMS program is available on CD.  To request the CD version, call CDEMS 

Technical Support at 1-800-478-3563 or 916-817-1401. 

Installing CDEMS 

1. Create CDEMS folder 

a) On the desktop or from Start button double-click on My Computer  

b) Select (C:) > File > New > Folder > Type “CDEMS” > Enter 

You will see a folder on your C:  drive named “CDEMS” 

c) Or, create a CDEMS folder in a shared directory on a network server  

 

2. Determine your version of MSAccess 

a) Click on Start > Programs  at the bottom of the desktop screen 

b) Locate Microsoft Access in the program list > Access 2000, 2002 & 2003 appear with a 

maroon icon and do not include a version date; Access 2007 and 2010 include the 

version year as part of the application name 

 

3. Download CDEMS 

g) Start your Internet browser 

h) Enter the net address www.cdems.com > Enter 

i) Click Download Files from the navigation list 

j) Download files from the appropriate list for your version of Microsoft Access.  Save the 

basic files into the CDEMS folder at the location you created in Step 1. 

e) Double-click on cdem_DataEntry_6-7-10 file or latest version of the Data Entry 

program > Save in C:\CDEMS 

f) Double-click on rpt_7-30-10 or the latest version of the Reports program > Save in 

C:\CDEMS 

g) FIRST TIME DATA FILE INSTALLATION: double-click cdem_dta > Save in 

C:\CDEMS. 

 

CURRENT CDEMS USERS:  extracting the cdem_dta file will OVERWRITE 

EXISTING DATA ï do not unintentionally reinstall the cdem_dta file. 

  

4. Extract files 

a) Access 2k extraction:  click on cdem_dta.EXE > Zip-It window appears > Extract Files 

> Self Extract > Execute > Close 

b) Extract cdem_6-7-10.EXE and rpt-7-30-10.EXE files in the same way. 

c) Access 2007/2010 extraction: see notes on next page 

 

http://www.cdems.com/
http://www.cdems.com/
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5. Create CDEMS icons   

a) Navigate to the location of your CDEMS folder (usually at C:CDEMS through “My 

Computer” window or through “My Network Places” if installed on a network server) 

b) Right-click first on the cdem_DataEntry_6-7-10.mdb file > click “Send To” > Desktop 

(create shortcut) 

c) Next, right-click on the rpt_7-30-10.mdb file > click “Send To” > Desktop 

d) Close the CDEMS file window, returning to your desktop 

e) Right click on the cdem_DataEntry_6-7-10.mdb shortcut icon > Rename 

> Type “CDEMS Data Entry 6-7-10” to rename the icon.  For easy 

reference later, always include the CDEMS version date (i.e., 6-7-10) 

when naming shortcuts. 

f) Right click on the cdem_Rpt_7-30-10.mdb shortcut icon > Rename > 

Type “CDEMS Rpts 7-30-10” to rename the icon.    

g) Right click on new CDEMS icons on your desktop > Properties > 

Select Shortcut tab > Change Icon > Pick CDEMS green tree icon > 

OK > Apply > Close 

 

Access 2007/2010 Installation Notes 

 

On the “Download Files” page at www.cdems.com, click on CDEMS Programs > scroll down to 

the Access 2007 Files.  These files work for Microsoft Access versions 2007 and higher.  Note 

that only the Data Entry program is an Access 2007 .accdb file; the earlier .mdb format works for 

the Reports program and the data file.  

 

Three options (file formats) are 

available for each of the three main 

CDEMS Data Entry, Reports and data 

files: 

¶ .zip 

¶ .exe 

¶ .accdb/.mdb (unzipped) 

 

Double-click to download only one set 

of file formats -- try the .zip files first 

(option #1) as this format is most likely 

to be successful.  Save in the CDEMS 

folder on your local computer or to a 

shared directory on your network server.   

http://www.cdems.com/
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Right-click each .zip file > Extract All 

to unzip all CDEMS files > Browse to 

point to the CDEMS folder where the 

file should be saved > Extract. 

 

If option #1 files cannot be unzipped, try 

downloading the executable files (option 

#2) or unzipped files (option #3) though 

.mdb files are frequently blocked by 

security settings during download.  If all 

options fail, unzipped files can be 

obtained on a CD; send a note to 

jackie@cdems.com.  

 

Enable Content in Access 2007/2010 

 

Double-click on the unzipped Data Entry program file to begin using CDEMS.  Expect a security 

warning blocking access to the program.  To move beyond the Data Entry and Reports welcome 

screens, click Options in the Security Warning area below the Access menu bar > Enable this 

content > OK. 

 

 

 

The opening CDEMS screen will 

display.  Content must be enabled 

each time CDEMS is opened unless 

CDEMS is identified as a Trusted 

Location in Microsoft Access – see 

next page for instructions. 

 
 

mailto:jackie@cdems.com
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Make CDEMS a Trusted Location 

 
From the Security Options window, click Open the Trust Center to permanently identify 

CDEMS as a trusted location and avoid the “Enable this content” message each time CDEMS is 

opened. 

 

NOTE: Administrator-level 

permissions may be required to 

set up trusted locations.  IT 

assistance may be needed. 

 

 

For multi-site installations, 

CDEMS must be identified as a 

trusted location in Microsoft 

Access at each CDEMS location.  

If CDEMS programs are 

installed locally and linked to a 

data file on a server, both the 

local CDEMS folder and the 

server directory where CDEMS 

data is stored must be identified 

as trusted locations.  

 

 

Next, click Trusted Locations in menu bar at the left margin > Add new location > OK 
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Click Browse > navigate in the directory window to the CDEMS folder on your computer and/or 

network > single-click on the CDEMS folder name  > OK. 

 

 
 

 

Verify the path of the CDEMS secured location.  Be sure to check Subfolders of this location 

are also trusted in the Microsoft Office Trusted Location window > then click OK.  This 

identifies all files within the CDEMS folder as trusted files. 
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Finally, click Allow Trusted Locations on my network  > OK.  Press OK once more on the 

Security Alert screen.  CDEMS programs will now open directly each time without security 

blocks. 

 

If the Data Entry and Reports programs are installed locally on the C: drive and linked to a data 

file on a network server, repeat the process to establish both locations as trusted locations. 

 

Access 2007/2010 Troubleshooting Tips 

 

Missing References 
 

If the Data Entry program file is uncompressed and open when the 64-bit incompatibility 

message appears, review program references according to the steps below:  

 

¶ Open the CDEMS Data Entry program (version for Access 2007) 

¶ Click on Modules in the object panel to the left 

¶ Double-click on basFormUtils > click on Tools in the upper menu bar > click on 

References 
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1. Verify that references match those on the References – db1 screen shot (left).  Uncheck 

any missing references and scroll down the available references to locate Object Library 

versions that match your system (versions 10.0, 11.0 or 12.0).  Check to add missing 

references.  All five references must be checked for the program to function properly. 

 

2. Click OK 

 

3. Click the red "X" in 

upper right corner to 

close the Visual Basic 

window.  Save changes. 
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Stripped Modules 
 
If on opening the basFormUtils module, you find the module empty (no VBA code), security 

settings on your system have likely stripped module content from the program during download 

(common on server installations). Try downloading fresh copies of the program files into a 

CDEMS folder on your local C: drive.  Unzip the files and open on the local C: drive to verify 

the modules contain VBA code.  If the programs open successfully, copy/paste the unzipped files 

onto the server where a CDEMS folder has been created and identified as a trusted location.  

 

Network Installation 

Network installation of CDEMS is possible to enable multiple use of a single registry within an 

organization.  Two configuration options are available: 

 

¶ Full installation of CDEMS programs and the data file on the server.  With this 

configuration, all CDEMS files (cdem_10-12-09.mdb, rpt_6-26-09.mdb, cdem_dta.mdb)  

¶ are installed in a CDEMS directory located on the server.  A path or shortcut is created 

on each user‟s computer to access CDEMS.  

 

¶ Local program installation with the data residing on the server.  With this option, only 

the data file (cdem_dta.mdb) is installed on the server.  Microsoft Access and CDEMS 

program files (cdem_10-12-09.mdb and rpt_6-26-09.mdb) are installed on each user‟s 

computer.  This installation method provides significantly speedier compilation of forms 

and program operation than a full network installation. 

 

Note: The CDEMS programs (cdem_10-12-09.mdb and rpt_6-26-09.mdb) must be 

linked to the cdem_dta.mdb file in the CDEMS directory on the server.  On the first 

opening of the programs, the user must point to the location of that cdem_dta.mdb file on 

the server.  Alternatively, the file can be re-linked by opening each CDEM program > 

click Tools in the menu bar > Database Utilities > Linked Table Manager.  Next 

check the Select All and Always Prompt for New Location boxes > OK.  At the next 

window in the “Look in” box, navigate to the CDEMS folder on the server and then click 

on the cdem_dta.mdb file.  CDEMS tables will then be re-linked to the common data file 

on the server.  

CDEMS Upgrades 

Check www.cdems.com periodically for periodic upgrades as enhancements to the CDEMS 

programs.  Follow instructions for downloading data entry and reports program updates covered 

in the Installation section of this Guide.   

 

 CAUTION WHEN UPGRADING 
When upgrading CDEMS, DO NOT REINSTALL THE SAMPLE CDEM_DTA file. Once 

you start entering data into your registry, your patient information is stored in the 

cdem_dta.file.  Reinstalling the sample data  file will write over your data! 
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 TIP: Visit www.cdems.com to add your name to the e-mail list for electronic 

notification of program updates and other news about CDEMS. 

Initial Patient Data 

The most challenging part of starting and maintaining CDEMS is data entry.  Before anyone can 

use CDEMS, each patient‟s contact information, current health conditions, current medications, 

and last dates for tracked specialty services and labs (including the results obtained) need to be 

entered into the database.  If you could easily keep track of all this – you wouldn‟t need CDEMS! 

 

If your billing program or EMR allows exporting at least patient demographics, your registry can 

be jump-started by importing data rather than manually entering everything.  For the rest of the 

information, the typical response is a chart audit.  This is a major effort.  It‟s not uncommon for 

an experienced chart auditor to only review 25 charts in a day. So budget plenty of time, or do a 

„moving‟ chart audit – each week, chart audit only for the patients coming in for a visit.  The 

danger of this is that you will not ever get to those not coming in so be sure to catch up with them 

soon!  CDEMS has a feature to create a data abstracting form just for the items you are tracking.  

First set up your CDEMS with instructions in the next section, then print a master abstracting 

form using the “New Patient Form” option found on the Print tab of CDEMS. 

Data Imports from Other Systems 

Often billing system or EMR data is available to initially populate patient demographic 

information in CDEMS.  If billing information can be exported to an Excel or comma delimited 

file, you‟re in business!   

 

Clinic_code, chart_number and start_date are the REQUIRED fields needed to enter a patient 

into the CDEMS registry, but export as many of the CDEMSdemographic fields as can possible 

from the the billing system to populate the registry quickly.  Create your clinic in CDEMS 

tlkpClinic first (look ahead a few paragraphs to the Clinic Setup section of this guide for 

assistance).  Next, rework the Excel spreadsheet by renaming and inserting columns to match the 

columns found in tblDemo: Patient_ID (leave blank), clinic_code, chart_number, last_name, 

first_name, dob, sex, ethnicity, primary_language, address1, address2, city, state, zip, phone1, 

phone2, pcp, insurance, _date, start_date, end_date, last_update_date, migrant, homeless, other.  

The match on exact column order is critical.  Manually populate two required fields in the import 

spreadsheet: 

 

¶ Enter your CDEMS clinic_code for every patient. 

 

¶ Add a default date in the start_date column for every patient.  The CDEMS reports 

program looks at start_date as the first date a patient was active in the registry even if 

earlier healthl information is recorded.  So, establish a common start_date for every 

patient in the import file using a date that encompasses the earliest historical data that 

will be recorded for baseline reporting, or simply use the start of a QI project.  If your 

strategy is to build a registry with current patient data going forward, the current date 

works fine as a start_date.   

 

Copy all columns of data (exclude headings) from the import file and append to tblDemo in the 

cdem_dta.mdb file.  You‟re now ready to enter health information for the patients; start with the 

primary health condition and diagnosis date first.  You‟re on your way! 

http://www.cdems.com/
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Maintaining Data Entry 

“Garbage in – garbage out!”  For your CDEMS registry to be valuable to your organization, the 

data must be accurate and timely.  Fortunately data entry is straight forward and quick, but still 

the biggest headache for clinics.  A CDEMS lab interface can assist by electronically 

downloading lab results directly into the CDEMS registry.  At this time, interface programs exist 

for PAML, QUEST, LabCorp/Dynacare, PacLab, and Dynacore, and other customized laboratory 

interfaces are continually being developed.  Electronic lab downloads are an integral component 

of efficient and successful CDEMS use.  See the “Electronic Lab Interface Guide” for detailed 

information. 

CDEMS First Steps 

CDEMS is very flexible in what it stores, how it stores it, and how it displays data.  During the 

setup of CDEMS, several initial decisions must be made.  Scan the next few sections of set up 

instructions to become familiar with the choices you must make before actually beginning clinic 

setup. 

Patient IDs 

Every patient in the CDEMS registry must have a unique chart number.  CDEMS data is matched 

to a particular patient using a combination of the clinic_code and the chart_number fields.  This 

insures that in large systems where the chart number is not unique to one patient, each patient 

can be uniquely identified.  If your clinic does not use chart numbers, you will need to assign a 

unique identifier for each patient in CDEMS.  For example, last name combined with month, 

day, and year of birth successfully creates a unique identifier.  For example, Ann Jones born on 

July 1, 1933 would have a chart_number of “Jones07011933”. 

Clinic Set Up 

Clinics are defined in the tlkpClinic table in CDEMS.  At least one clinic must be entered in the 

tlkpClinic table in order to use the program.  A fundamental choices are made in first setting up 

clinics in CDEMS – (1) grouping patients within a clinic by health condition, (3) setting up 

“pilot” and “spread” clinics, (3) tracking patients more holistically with information about ALL 

conditions stored within a single clinic, or (4) a crossover version of strategies. 

 

  

In the first case, clinics are created by condition -- e.g. "DMClinic" or "Asthma".  All patients 

with diabetes are placed in the DM Clinic; all patients with Asthma are in the Asthma clinic.  

Patients with both conditions would be in BOTH clinics with information stored separately 

within each clinic for each health condition.  Patients can exist in multiple clinics within a 

CDEMS registry if they have multiple chronic conditions. For some conditions (e.g. diabetes and 

asthma) this works quite well because there is little overlap in tracking measures.  For other 

combinations such as diabetes and cardiovascular there is much overlap, and this approach 

becomes more burdensome.  

 

A common approach for tracking pilot groups of patients with a health condition is the use of 

separate “pilot” and “spread” clinics.  For example, Dr. Dooright‟s pilot group of diabetes 

patients in the Healthy Body Clinic might be placed in a clinic named “Healthy Body DM Pilot” 
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and assigned the clinic code “HBC_DMP”.  Everyone else would be tracked in the “DM Spread” 

clinic, HBC_DMS. 

 

Note:  Since the Reports program is designed to report around health condition, an 

alternative approach for separating a “pilot” group is use of health condition tags to 

identify patients as part of a pilot population.  For example, patients in a “Diabetes: 

clinic who are also part of a cardiovascular study might have a condition called “CVD-

Pilot” as well as DM-2.  The CVD-Pilot condition would be defined to match the 

cardiovascular condition setup in CDEMS.   When reporting on the CVD-Pilot group, 

only the subset of diabetes patients with the “CVD-Pilot” condition would be included.    

 

With a holistic approach, all patients are grouped together and multiple conditions tracked within 

a single clinic.  The status of all conditions is combined and summarized in a single progress 

note.  

 

Once the clinic approach is decided on, begin setting up clinics by double clicking the CDEMS 

icon to open the CDEMS Data Entry program.  Clinic codes and Progress Note styles are added 

or edited in the Clinic table. 

 

1. From the opening window of the Data Entry Program, press F11 function key on your 

keyboard > click on Tables tab 

2. Double-click on tlkpClinic to open (see CDEMS Table View - Fig. 1) 

 

 

3. The Clinic table is shown in Fig. 2.  Start by typing the full name of the clinic in the Clinic 

field. 

 

Fig. 1 - CDEMS Table View 

Fig. 2 - Sample Clinic SetupTable 
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4. When setting up multiple clinics, each clinic must have a unique clinic_code.  Adopting a 

consistent number of clinic_code characters helps ensure accurate reporting for individual 

clinics or aggregated reporting.  For example, “HBC_DMS,” “HBC_DMP,” and 

“HBC_AST” are good examples of a unique 7-character code naming convention.   

5. Enter the Progress Note style in the Type_Form field.  While each style contains the same 

basic information, several style selections are available to choose from.  Read about 

“Progress Note Styles” in the next section to determine the style best suited for your clinic.  

If uncertain which to choose, start with style 2 because it displays the largest number of 

measures on a single page.  The style can be changed at any time by entering a new value in 

the Type_Form field in this table.  Style is defined at the clinic level so it‟s important to 

reach consensus among users about the Progress Note style selected.   

6. Enter a graph style in the Type_Flowsheet field (see description of graph styles in the “Graph 

Styles” section following.  To omit graphs, simply leave the Type_Flowsheet field blank. 

7. The Type_Overflow column defaults to “1” for all Progress Note styles.  The overflow sheet 

is added automatically when page 1 of the Progress Note fills.  The same overflow sheet is 

used for all styles. 

8. Leave Clinic_Group column blank; this field is unused. 

9. The Comments column is reserved for entries needed to produce aggregate reports.  Clinic 

codes in CDEMS have two purposes.  The first purpose is to assist in unduplicating patients 

that may have duplicate chart numbers, and the second is to allow grouping of patients in 

reports.  If your system has unduplicated unique chart numbers, there are many choices in 

creating “clinics” and assigning patients to them in CDEMS. A common approach is to 

create a separate “clinic” for patients within pilot groups.  For example, Dr. Dooright‟s pilot 

group of diabetes patients in the Healthy Body Clinic might be placed in a clinic named 

“Healthy Body DM Pilot” and assigned the clinic code “HBC_DMP”.  Everyone else would 

be tracked in the “DM Spread” clinic, HBC_DMS.  A virtual total clinic could combine the 

regular clinic and pilot groups together to produce summary reports for a Total clinic with a 

clinic code of “DM-TOT”.  Another clinic (Healthy Body-AST) might be created to track a 

group of asthma patients for another provider. 

 

Again, it‟s extremely important for accurate aggregate reporting to ensure that each clinic has 

a unique clinic_code.  Implementing a consistent length for each clinic_code ensures unique 

clinic codes.  In the examples, “HBC_DMP,” “HBC_DMS,” “HBC_AST” contain unique 7-

character codes.  Erroneous reports would be produced for an “HBC” clinic because “HBC” 

is included within all the other clinic codes used in this example.  Clinic_codes entered in the 

Comments column of tlkpClinic identify the clinics to be aggregated in the Total Clinic (see 

sample at Fig. 2).  DO NOT USE THE COMMENTS COLUMN FOR OTHER PURPOSES. 

 

10. When finished, Close the tlkpClinic table > OK.  Entries to tlkpClinic are automatically 

saved.   

Progress Note Styles 

CDEMS is very flexible in allowing users to choose how the Progress Note looks.  CDEMS 

comes with several Progress Note styles to accommodate differences between clinics.  Since 

styles are assigned at the clinic level, each clinic within CDEMS can have a different style.  Each 

of the style templates displays the same basic patient information.  Templates for “1list” and 

“2list” styles allow for the addition of user-defined list boxes displaying historical data (without 

graphs) on selected labs and services.  A Progress Note style must be indicated for each clinic.   
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Progress Note Style 1 is the basic CDEMS model displaying 

up to 9 related conditions, 12 meds, 13 services and 9 labs on 

the page.  Patient vitals and demographic information is 

displayed at the top of the page with summary information 

displayed along the left side.   PCP notes can be recorded in 

the blank area on the right side of the page.  Optional graphs 

plotting lab values and trends from the previous 24 months are 

displayed on a separate graphs page.  Typically, the graphs 

page is used as a patient handout.  An automatic overflow 

page displays more information, if needed.   

 

 

 

 

 

 

 

Progress Note Style 2 displays current data and an update 

area in three columns in the upper half of the page.  

Dictation notes may be pasted or entered in the lower half 

of the Progress Note.  Optional graphs plotting lab values 

and trends from the previous 24 months are displayed on a 

separate graphs page.  Typically, the graphs page is used as 

a patient handout.  An overflow page automatically 

displays more information, if needed.   

 

 

 

 

 

 

Progress Note Style 3 displays the patient summary 

information down the left margin, like Style 1, but graphs are 

included in the main part of the Progress Note.  Dictation is 

pasted or entered on the reverse side of the form.  A duplicate 

set of graphs for patient distribution can printed on page 2.  

Overflow information prints on page 3, if needed. 

Fig. 3 - Progress Note Style 1 

Fig. 4 - Progress Note Style 2 

Fig. 5 - Progress Note Style 3 
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Progress Note ñ1listò displays patient summary 

information down the left margin in the Style 1 

format with the option for adding 8 list boxes 

showing historical data (dates & results) on 

selected labs and services.  Weight and BP are 

automatically summarized in list boxes 

regardless of the health condition; up to six 

other list boxes may be specified by the user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Progress Note ñ2listò displays the patient 

summary information in the upper half of the form, 

like Style 2, with the option for adding 12 list boxes 

at the bottom of the page.  Weight and BP are 

automatically summarized in list boxes regardless 

of the health condition.  Up to ten other list boxes 

may be added for labs and services specified by the 

user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 6 ï Progress Note Style ñ1listò 

8 list boxes display 
patient histories 
(dates/results) for 

selected labs & 
services. 

Fig. 7 ï Progress Note Style ñ2listò 

Up to a dozen 
list boxes display 
short histories of 
patient data for 
selected labs 
and services 
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Lists are set up in tlkpSetup, as illustrated in Fig. 8.  Lists are added at the * in the empty row at 

the bottom of this table similar to the examples shown.  Note: the order column here does not 

control the display sequence of boxes on the progress note; list boxes appear in alphabetic order 

by raw code. 

 

Progress Note 1A is a Style 1 progress note customized for tracking Asthma.  Referencing Fig. 

9, note the information boxes near the bottom of the page displaying # of visits in the last 12 

months, Steroid Bursts in the last 12 months, and Max Peak Flow recorded.  Coding within this 

form assumes use of an Asthma setup with the following raw codes defined in tlkpCrosswalk for 

Peak Flow and Steroid burst and identified in the correlating Asthma setup in tlkpSetup.  A 

listing of Health Education Topics pertinent to Asthma patients is also displayed at the bottom of 

the Asthma progress note.   

 

Type_code Working_code Raw_code TlkpSetup ï related_field 

Lab Peak Flow PEF Peak Flow 

Lab Steroid burst Steroid burst Steroid burst 

Fig. 8 ï Sample list setup in tlkpSetup 
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The Overflow sheet (page 3) automatically continues the display of information when page 1 of 

the Progress Note is filled.  There is only one style of overflow sheet and the clinic setup table 

sets the Overflow default style to 1.  

Fig. 9 - Progress Note 1A for Asthma 
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Graph Styles 

Graph style is assigned at the clinic level.  You may choose between two styles as shown in 

Figures 10 and 11 below.  Graph styles can be mixed or matched with Progress Note styles or 

turned off altogether.  Simply leave the Type_Flowsheet cell empty in tlkpClinic to suppress 

graph printing. 

 

 

Graph Style 1 can be used with any style of Progress 

Note.  Fig. 10 provides a view of Style 1 graphs printed 

on page 2 of the Progress Note.  A full-page illustration 

of this formatting style is available in the Appendix.  

 

 

 

 

 

 

 

 

 

 

Graph Style 2 may be used with all Progress Note styles.  This 

format features a Recommendations box reviewing treatments 

and standards of care related to the patient‟s health condition 

along with the graphs.  The Recommendations box lists 

tests/treatments along with standards of care, date last done & 

results, and additional information (see Graph Style 2 samples 

shown at Fig. 11 and Fig. 12).  A full-page illustration of this 

graph style is available in the Appendix 

 

Note: Using Progress Note style 3 in combination with a graphs 

page produces graphs on page 1 of the Progress Note and 

reprints them again on page 2 for a handy patient handout. 

 
 

 

Fig 10 - Graph Style 1 

 

Fig. 11 - Graph Style 2 

Fig. 12 ï Recommendations Section ï Graph Style 2 
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Default Clinic 

The default clinic is the clinic name that automatically appears as the selection on the CDEMS 

opening screen.  Even if only one clinic is entered in the clinic table, that clinic code must be 

entered as the default clinic.  To change the default clinic, select tlkpDefaults from the Table list 

available in database view (F13).  Type the desired default Clinic_code in the clinic_default 

column.  Only one clinic can be listed as the default.  Close the tlkpDefaults table. 

 

Note:  The “read copyright” entry in clinic_support_DCP records that the copyright page was 

read when you first began using CDEMS.  The program checks for this entry each time it opens. 

 

Customizing CDEMS 

The true beauty of CDEMS is its potential for customization.  Almost everything in CDEMS is 

customizable -- an unlimited number of conditions and related diagnoses, meds, services, and 

labs may defined by the user.  This section of the User Guide explores advanced customization 

options for enhanced and expanded use of CDEMS.  These in-depth topics are optional and are 

not needed to begin using CDEMS.  

What to Track 

Some thought should be directed to what you need and how to store it.  Again, start with one 

condition and spread to additional conditions systematically.  When in doubt, store less – not 

more.  CDEMS can be continually altered to meet your needs, and it will be easier to maintain 

and more likely successful if kept lean and focused on your priorities.  Tracking can be as simple 

or as complex as you wish.  The Setup Wizard is the innovative feature that facilitates custom 

definition of CDEMS tracking variables.  

The Setup Wizard - Customizing Measures 

New health conditions can be defined for tracking in the Setup Wizard.  In addition, meds, 

services, labs, and related diagnoses associated with a health condition can be added to the 

measurement list or removed according to the preferences of the user.  All setup variables are 

defined at the condition level (not at the patient level) and determine what is tracked in the 

database and what is reported in the CDEMS Progress Note and reports.   Access the Setup 

Wizard from the opening screen of the CDEMS Data Entry program by pressing the F11 

function key to work in database view > click on Forms > double-click on frmSetUpWizard. 

 

CDEMS comes with measures predefined for diabetes (DM-1 and DM-2, Asthma, 

Cardiovascular, and Adult Ppreventive Health services.  Fig. 14 shows an example of the Setup 

Wizard with DM1 as the selected health condition.  Note the related Dx, Rx, Services and Labs 

shown in the left-hand box for each category.  Each list is a subset chosen from the All Possible 

Dx, Rx, Services and Meds boxes on the right.  While the related variables for diabetes and adult 

Fig. 13 - Default Table 
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preventive health are pre-coded into CDEMS, these lists can be customized to meet your tracking 

needs.  

 

  

Add a New Measure 
Double-click on an item in the “All Possible” list to include it into the “Related” box for tracking 

with the specified high-level condition or click on the item and use the left arrow key (<) to 

include in the “Related” box. 

 

Delete a Measure 
To remove a variable, double-click the item or use the right arrow key (>) to remove it from the 

“Related” list.  Removing a variable does not erase any patient data that was collected for this 

measure.  The data is still retained in the database but no longer appears on the Progress Note or 

as an available reporting parameter for the health condition for which is no longer associated. 

 

 

Fig. 14 ï Setup Wizard (DM-1 example) 
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Add a NEW Measure to the All Possible List 
Adding a new variable to the All Possible List is a 2-step process.  Step 1: add the measure to the 

All Possible list.  Step 2: create the association of the measure with the high-level health 

condition. 

 

Fig. 15 shows an example of adding DKA (diabetic ketoacidosis) as a new health condition for 

tracking with DM-1.  DKA is typed in the Green condition box in the upper left corner of the 

Setup Wizard screen > press Enter.  Since the condition is not already in the All Possible list, 

you are prompted to add it along with a raw code.  The raw code is the physical code used to 

store the record internally in CDEMS.  This code may or may not relate to CPT billing codes or 

other diagnostic codes used by your clinic.  Usually, I recommend accepting the default raw 

code. 

 

 TIP:  Be aware that Progress Note labels display only 13 characters and long descriptive 

entries may be severely truncated on the Progress Note.  Thus “DKA” may display better 

on the Progress Note than the truncated form of diabetic ketoacidosis -- diabetic keto.  

  

Once a new health condition has been added, the new condition is now visible in the All Possible 

Dx list.  To add DKA as a “Related” condition for Type 1 Diabetes, first select DM-1 as the 

high-level health condition in Step 1, then select DKA from the “All Possible” Dx list and click 

the left arrow (<) to include in the related condition list for DM-1 (or simply double-click DKA 

in the “All Possible” list). 

 

Similarly, enter new meds, labs and services in the respective “New” boxes for each variable.  If 

the variable is not already on the All Possible list, you will be prompted to add it.  A pop-up box 

prompts for a raw code entry.  The raw code is the physical code used to store the record 

internally in CDEMS.  This code may relate to CPT billing codes or other diagnostic codes used 

by your clinic.  The default raw code is the label you entered in the condition box, and usually 

accepting the default raw code works best.  Double-click (or use left arrow) to move the new 

med, lab or service from the “All Possible” list to the “Related” list for tracking in CDEMS. 

 

Delete a Measure from the All Possible List 
It‟s possible and a good idea to clean out unwanted selection choices from the “All Possible” 

lists from time to time.  When setting up tracking variables for a new condition, multiple 

variations of the same measure often result within sections of the Setup Wizard.  To delete a 

variable, select the measure from any of the “All Possible” lists > press the Delete key on your 

Fig. 15 ï Setup Wizard ï Add New Variable 
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keyboard to eliminate the redundant or unused measure.  You‟ll be alerted that “all data of this 

type will be deleted” from your registry – this includes patient data if the deleted measure has 

been used.  Before deleting entries in the Setup Wizard, do a quick check in the corresponding 

patient table to confirm the variable has not been used. 

  

Dropdown Lists - Customizing 

Several patient information fields (PCP, City, Insurance, State, Ethnicity, Language) offer 

dropdown lists for fast and easy selection.  These dropdown lists may be pre-loaded at setup time 

or added to on the fly as patient information is entered or edited.  The dropdown lists increase 

data entry speed and help to ensure the integrity of data.  Click on the arrow to the right of any of 

these cells to see existing data lists.  An item may be chosen from the existing list or simply type 

new data in the empty cell.  When a new entry is detected by CDEMS, the user must confirm 

whether to permanently add the item to the dropdown list.  Instructions follow for working with 

specific dropdown lists. 

 

Pre-Enter Provider List 
Providers may be batch entered or edited in the tlkpPCP table. 

a) In Table view, double-click on tlkpPCP 

b) To eliminate sample providers initially listed in the PCP table, click on Edit > Select All 

Records > Delete All Records 

c) Then enter the clinic_code and provider names.  If a PCP provides service for more 

than one clinic, the provider name must be entered for each clinic. 

d) Click on inner “X” in upper right corner to close tlkpPCP 

 

 TIP:  The data entry features incorporated in CDEMS allow users to type the first 

couple of letters in a provider, city, insurance, ethnicity, or language field, and the 

program guesses to complete the rest of the word.  To benefit from this feature, make 

the first letters of the items in these lists as distinctive as possible.  For example, enter 

Smith, Andy in your PCP dropdown list instead of Dr. Andy Smith. 

 

Customize Insurance List 
Insurance payer information may be batch entered or edited in the tlkpInsurance table.  Careful 

thought in creating a good payer selection list will be well rewarded with the ability to generate 

meaningful documentation for pay-for-performance reimbursements.  Think ahead to anticipate 

payer distinctions that may be needed for this type of reporting -- for example, should 

“Medicare” be fine tuned to include types of Medicare (e.g. Medicare-PartB)? 

   

a) In Table view, double-click on tlkpInsurance 

b) To eliminate sample payers initially listed in the Insurance table, click Edit > Select 

All Records > Delete All Records or click on gray box at left edge of row to select a 

specific insurance provider > click Edit > Delete 

c) Then enter insurance name and insurance type (insurance type is the NUMBER best 

corresponding to the category for this insurance 1=commercial, 2=medicaid, 

3=medicare, 4=unknown) 

d) Click on inner “X” in upper right corner to close tlkpInsurance 
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Customize Ethnicity List 
Fig. 16 shows the data pre-defined in the Ethnicity table.  

Additional ethnicities are easily added on the fly as needed 

when patient information is entered.  Simply type new data 

in the Ethnicity cell and confirm at the prompt to 

permanently add new data to the drop-down list.   

 

Additional ethnic groups may also be batch entered or edited 

in the tlkpEthnicity table. 

a) In Table view, double-click on tlkpEthnicity 

b) Enter new ethnic group name(s) at the first empty 

row in the table  

c) Click on inner “X” in upper right corner to close tlkpEthnicity 

 

 

Customize Language List 
English and Spanish are the languages pre-defined in the CDEMS Language table.  Additional 

languages may be batch entered or edited in the tlkpLanguage table. 

a) In Table view, double-click on tlkpLanguage 

b) Then enter new languages at the first empty row in the table 

c) Click on inner “X” in upper right corner to close tlkpLanguage 

 

  

Modify Default State 

WA is the default State abbreviation; to change the default state:   

a) In Form view, click on frmNewPatient > Design (located on menu bar at top of 

window).  The form will appear with the layout grid of dots in the background. 

b) Double-click the unbound box next to the “State” field 

c) Click on Data tab 

d) Enter your state‟s 2-character abbreviation as the default value 

e) Click on inner “X” in upper right corner to close text box 

f) Click on inner “X” in upper right corner to close frmNewPatient 

g) Repeat steps a-f on frmNewPatientForm, changing both the control source and default 

value to your 2-character state abbreviation. 

 

CDEMS Tickler 

 

The CDEMS Tickler serves as a reminder and early warning system to 

draw provider attention to labs and services that are due or outside of the 

acceptable result range.  Customization of Tickler parameters takes place 

directly in tlkpSetUp where standard frequencies of labs and services and 

thresholds for poor and borderline acceptable results are defined.  Read the 

short description of each Tickler parameter to learn about setting your targets: 

Fig. 16 - Ethnicity Table 
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¶ std_freq:  The tickler uses the standard frequency value to calculate how often a test 

is due.  The frequency is expressed in number of days between tests (e.g., once a year 

would be every 366 days).  A last test date within 60 days of the standard-frequency date 

is shaded in green to alert the provider that the re-test date is approaching.  Last test 

dates beyond the standard frequency are highlighted in red on the progress note to warn 

that the test is overdue. 

 

¶ std_poor:  The system uses the std_poor value to evaluate whether a test result is 

outside the threshold range.  The std_poor value is qualified as a > (greater than) or < 

(less than) value to measure whether a result against the target result range.  When a test 

result falls within the std_poor range, the result is shaded in red on the progress note to 

warn the provider of a poor result that needs attention. 

 

¶ std_good:  This parameter is somewhat of a misnomer since the tickler actually uses 

the standard_good value to evaluate whether a test result is in the “borderline 

acceptable” range, approaching the warning threshold.  The entry in this field can be a 

single value for which an exact match triggers a warning or most often it will define a 

range of values (e.g. between 6.8 and 7.0 for HbA1c) to trigger an alert.  When a test 

result falls within the std_good range, the result is shaded in green on the progress note 

to provide an early alert of a borderline acceptable result that is approaching the poor 

target threshold. 

 

Tickler Setup 

 
a) From the CDEMS Data Entry program opening screen, press F11 function key to work 

in database mode 

 

b) Click on Tables > double-click on tlkpSetup 

 

c) Clear all entries in the std_freq, std_poor and std_good columns to INACTIVATE the 

Tickler.  The information in these columns is used only by the Tickler system, so 

clearing entries here will not adversely impact anything else in CDEMS.  To quickly 

inactivate the Ticker, sort the std_freq, std_poor and std_good columns in tlkpSetup in 

descending order.  This action will move all tickler entries to the top of the table for easy 

cell-by-cell deletion -- delete only the content of each cell, NOT the entire column. 

 

d) To CUSTOMIZE the Tickler system, you may find it helpful to filter on type_field for 

easier editing.  For example, right-click on any cell where type_field=”Lab” (or 

“Service) > Filter by Selection > sort related_field column in ascending order to group 

labs together.  Simply add or change entries in the tlkpSetUp std_freq, std_poor and 

std_good cells to define the alert system for selected labs and services. 

 

Services may not have results entries, so values are optional in the std_poor column.  

However, if a value is entered in the std_poor cell, a std_good entry is required.  Enter 

“0” in the std_good cell if early alerts for borderline results are not desired.  Tickler 

entries are made by health condition so duplicate entries must be made in the tickler 

columns for DM-1 and DM-2 health status. 
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 TIP:   

¶ Use “>” (greater than), and “<” (less than) to define std_poor values 

(e.g. >10). 

¶ Use a range of values “between ### and ###” to define the 

std_good borderline acceptable range (e.g. between 8 and 10). 

 

Below are target goals established by the American Diabetes Association that are commonly 

used to establish CDEMS Tickler parameters for diabetes. 

 

Based on these ADA recommendations, sample Tickler fields are shown for health_status DM-1 

and DM-2 in the filtered Setup table below.  

  
health_status related_field std_freq std_poor std_good 

DM-1 Chol 366 >200 0 

DM-2 Chol 366 >200 0 

DM-1 HbA1c 90 >7 Between 6.5 and 7 

DM-2 HbA1c 90 >7 Between 6.5 and 7 

DM-1 HDL 366 <45 Between 50 and 45 

DM-2 HDL 366 <45 Between 50 and 45 

DM-1 LDL 366 >100 Between 95 and 100 

DM-2 LDL 366 >100 Between 95 and 100 

DM-1 Trig 366 >150 0 

DM-2 Trig 366 >150 0 

DM-1 Flu Vac 366   

DM-2 Flu Vac 366   

 

Take care not to overlap values for the criteria in the std_poor and std_good columns or the 

program will become confused and result in an error.  For example, std poor >10 and 

std_good between 9 and 11 cannot be evaluated because a 10.5 result would fall within both 

categories. 

 

e) When finished with entries, click on the X in upper right corner to close tlkpSetUp > do 

NOT save Design changes (entries in table cells are saved instantaneously as you type). 

 

The sample progress note at Fig. 17 illustrates Tickler parameters in action.  Lab and service 

dates and results within the normal range are displayed without shading on the progress note.  

Remember that shaded black boxes indicate outstanding referrals. 

Test ADA Goal 
 

HbA1c below 7 
Total Cholesterol below 200 
HDL above 45 
LDL below 100 
Triglycerides below 150 
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Recommendations - Customizing Graph Style 2  

The Recommendations section of Graph style 2 can be customized in the Setup table.  Fig. 18 

shows a partial view of the Setup table with recommendations fields.  Follow the instructions 

below to customize the recommendation entries: 
 

1. From the CDEMS Data Entry opening screen, press the F11 function key to work in database 

view. 

2. Click on Tables > double-click on tlkpSetup 

3. Scroll down to the Lab “type_field” section for each health condition that tracks the lab 

recommendations being modified.  This means you must enter the customizations for labs 

under DM1 and DM2 if the lab is tracked for both health conditions.  Locate the row for the 

lab you wish to customize.  Recommendation entries can be customized in the 

standard_comment_short, description, and standard_comment_long fields.  

Std_comment_short holds the standard of care; description is the name of the test/service; 

standard_comment_long provides brief information about why this is an important element 

of care. 

 

 

 

Warning: These services 
are performed annually 
and are all OVERDUE 

Early alert: HbA1c is 
within borderline 
acceptable range 

Warning:HDL is 
overdue;  LDL 
result >100 is in 
poor range 

No shading:  
Triglycerides are on 
schedule and within 
target results 

Early Alert: HDL result 
between 45 and 50 is within 
the borderline acceptable 
range.  

Warning: HbA1c 
recommended every 
90 days is overdue 

Outstanding nutrition 
education referral 

Fig. 17 - Sample Progress Note with Tickler alerts 
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4. Click on the inner “X” to close the table.  You will be prompted to save changes.  Click Yes 

to Save. 

Pick Lists for Services/Labs    

 

Pick list functionality helps to ensure accurate and consistent data 

entry of results through user-defined result selections or validation 

checks for acceptable service and lab results.  Results options or 

validation checks for services and labs are specified in CDEMS 

tlkpSetup.  Pick lists are applied to any health condition where the lab 

or service is tracked.  

 

Customizing Pick Lists 
 

Instructions below will guide the customization of pick list settings for labs and services in the 

CDEMS tlkpCrosswalk table. 

 

1. From the Data Entry opening screen, press F-11 function key or click on database view 

in the background 

2. Click on Tables object > double-click on tlkpSetup 

3. Scroll to bottom of the table > add pick list criteria in the last row of the table for each 

lab or service where specific results or error checks are desired.  Fig. 18a illustrates these 

entries in tlkpSetup and a description of each field follows. 

 

 

 

Fig. 18 ï tlkpSetup:  Customizing Recommendations 

Fig. 18a ï tlkpSetup with sample pick list std_alert settings 
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¶ Health_status”  “Any” 

¶ Type_field:  “Alert” 

¶ Related_field:  lab or service working code (validate working code in tlkpCrosswalk) – 

e.g. “HbA1c” 

¶ Order:  100 

¶ List_raw_code:  lab or service raw code (validate raw code in tlkpCrosswalk) – e.g. 

“ha1c” 

¶ Std_alert options: 

- Text results for services can be up to 8 characters max with each result bracketed with 

commas before and after – (e.g. smoke assessment results would be recorded in the 

std_alert cell as ,current,past,never,). 

- IsNumeric:  requires a  numeric result entry for either services or lab results 

- Between # and #:  requires result to be within the defined numeric range, inclusive of 

end points (e.g. exercise assessment results between 0 and 7 might be used to accurately 

record # of exercise days per week) 

- < or >: requires result to be greater than or less than a specified value   

 

Entering criteria in the std_alert cell for a lab or service requires that a result be entered 

during data entry for a completed lab or service.  A result can be chosen from the 

dropdown pick list or can be evaluated to meet defined validation criteria like IsNumeric, 

< or >, between # and #. 

 

The std_alert criteria in tlkpSetup must be modified or removed from the service or lab 

to enter other results or no result.  The pick list/validation code is bypassed and a result 

not required for referred or declined labs or services. 

 

 

Expanding std_alert Field Size (if needed) 
 

While most pick list choices will fit within the 50 character std_alert field in tlkpSetup, it could 

happen that a longer list of options exceeds the field size.  In this case, the std_alert field size 

will need to be modified in the tlkpSetup table in your data file.  Here‟s how: 

 

¶ Close all CDEMS 

programs > open the 

cdem_dta.mdb file 

directly. 

 

¶ Click on Tables > 

single-click on 

tlkpSetup, then click 

Design in the database 

view upper menu bar 

shown at Fig. 18b. 

 

Fig. 18b selecting tlkpSetup Design view from the data file. 
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¶ Next click on the std_alert field name in the upper part of the table shown at Fig. 18c. 

 

 

Fig. 18c std_alert in design view with field size property = 50 characters 
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¶ Reset the std_alert field size to 100 in the field properties at the bottom of the table 

(Fig. 18d). 

 

¶ Click on the “X” in the upper right corner of tlkpSetup to close the table > SAVE 

YOUR DESIGN CHANGES. 

 

¶ Click on outermost “X” in upper right corner to close Access and the data file. 

 

¶ Open the CDEMS Data Entry program and finish entering pick list parameters. 

   

 

 

 

Fig. 18d std_alert with field size increased to 100 characters 
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Using Pick Lists during Data Entry 
 

Where text entries are defined for a lab or service, a pick list of result choices automatically 

appears on the Data Entry screen as shown in Fig. 18e.  Click on the appropriate result to select.  

When a pick list displays, a result must be selected from the choices offered in the list.  Only one 

result may be entered for a lab or service on a specific date.  Entering no result is not an option if 

a result pick list or validation entry has been defined. 

 

 

 

When validation parameters are defined for a lab or service, the entered result will be evaluated 

to see whether it meets the criteria.  If the entered result fails the test, an error message displays 

with a short description of expected results.  See example shown at Fig. 18f where a message 

prompts for a numeric result between 4 and 20 for the HbA1c test result.  An acceptable result 

must be entered that meets the result or validation criteria defined for the lab or service in 

tlkpSetup. 

 

  

 

Fig. 18e ï Data Entry screen showing result options for smoke assessment 
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Pick lists and validation criteria are optional entries that can be used to improve the quality and 

credibility of data as labs and services are entered through the data entry screen.  For labs and 

services without an Alert entry in tlkpSetup, entering a result is optional (e.g. flu vaccine 

typically has no result) or any result is acceptable.   

 

 

  

Fig. 18f ï Data Entry screen with failed validation test message for HbA1c 
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CDEMS DATA ENTRY 

The CDEMS Cycle 

CDEMS is much more than a computer software package that is installed and used once a week.  

The program captures information about what happens in every visit, stores the data, and 

contains mechanisms for retrieving and summarizing the data using on-the-fly queries and 

reports.   

 

A. The CDEMS Progress Note contains 

provider notes about the patient‟s last visit 

and is stored in the patient‟s chart.   After 

the database is updated, but before the 

next patient visit, an updated Progress 

Note and Graph sheet are printed. 

 

B. During the visit, the provider updates the 

CDEMS Progress Note form by marking 

the checkboxes and notating dates.  

Assistants may record patient vital signs 

in the CDEMS weight, height, and BP 

fields.  The Style 2 Graph (with 

recommendations) can be used as a patient 

handout.   

 

C. After the visit, a copy of the annotated 

Progress Note is made and routed to the data entry person for updating.  The master 

Progress Note is filed in the patient‟s chart.  A copy of the annotated Progress Note 

should also be kept on file in the data entry area.  CDEMS data entry can be done 

directly from the patient‟s chart, but this requires close cooperation with medical 

records. 

 

D. After entering the new visit data and lab results, an updated Progress Note and graphs 

page are printed and placed in the patient‟s chart prior to the next visit. 

 

Using the Progress Note 

The success of CDEMS in improving care for chronic health conditions is dependent on the 

program being easy to use and maintain.  This is accomplished in several ways.  First, the 

CDEMS Progress Note takes the place of the current form used to record the visit.  No other 

forms are needed to update and report information to the database.  Second, the Progress Note 

requires minimal checkbox or text entries in the sidebars of the form.  And third, some update 

entries on the form may be handled by other staff or through automated lab interfaces. 

 

 

C 

D A 

B 

flowsheet 

Old 
flowsheet 

New 
DEMS 

PCP 
notes 

chart 
copy 
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Let‟s look at what happens during the typical visit. Once CDEMS is in place, a completed 

Progress Note for the patient resides in the chart for the provider to use during the visit (see 

sample at Fig. 19). 

 

 

Patient demographic information displayed at the top of the Progress Note is reviewed and 

updated as needed.  Here age and BMI are calculated from current values and printed on the 

form.  The date of the current visit and vital signs are entered, either by support staff or by the 

provider.  If the rest of the data is current and no new referrals for services or labs are ordered, 

the provider is done and needs only finish up with dictation notes. 

 

Changes in the conditions diagnosed and medications sections are noted using the “D/C” 

(discontinued) and the “Add” checkboxes in the yellow highlighted area to the right of each 

section. 

Recording Referrals & Declines 

Last received date is reported in the services and lab sections of the Progress Note.  A referral 

during the current visit is recorded by a check in the “Ref” column along with the date in the 

New Date (Ndate) column.  At the next visit, a shadowed New Date (Ndate) box reminds the 

provider to follow up on a pending referral from the prior visit.  If the referred service was 

completed, the provider enters the date completed.  If care is offered but declined, the “Dec” 

check box is marked and a decline date entered.  Subsequent Progress Notes will hold the entry 

in the Last Date box with a notation “d” for declined service.  For example, a notation of 

“d01/99” in the Flu vaccination Ldate column indicates that a flu vaccination was offered but 

declined in January, 1999.  In the lab section, last result and date are provided for each lab 

completed. 

 

Fig. 19 - Patient Progress Note 
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After the visit, the provider or support staff copies the Progress Note and files the original in the 

chart.  The copy is given to the data entry person and typically entered once a week.  The closer 

to the next visit the Progress Note is printed the more accurate are the Tickler alerts about when a 

lab or service is due.   

 

Lab results can be electronically merged weekly rather than manually entered.  This requires 

information from the lab in a usable format for CDEMS and computer support staff to create a 

custom lab interface.  Refer to “Electronic Lab Interface” section of the User Guide for detailed 

information. 

Updating the Progress Note ï Data Entry 

Open Data Entry Program 

Simply double-click the CDEMS Data Entry program icon on your desktop to start CDEMS.  

After a brief welcome screen, the program opens with the CDEMS Opening Screen (Fig. 20).  

Note three critical tabs at the top of the screen: Print, Entry, and Edit.  These tabs navigate you 

through the core features of the CDEMS Data Entry Program.  The next few pages provide a 

detailed description for using these tabs to enter, edit and print patient information in the 

CDEMS registry. 

Find a Patient 

Most functions for existing patients in CDEMS begin with selection of a patient from the 

Opening screen list in any of the three tabs.  New patients are added into the registry through the 

Entry > Add New Patient window.  The program opens to a patient list for the default clinic 

defined in tlkpDefaults.  Click the dropdown clinic list to search for patients located in other 

clinics.  Below are techniques for quickly locating a patient in the registry without typing the 

entire chart number. 

 

Fig. 20 - CDEMS Opening Screen 
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Filter Patient List 
Enter a partial chart number to view charts beginning with that number only.  For example, if 

the first number of the desired chart begins with a 005, type the number 005 in the chart 

number box > Enter.  In this example, the patient list narrows to include only patients whose 

chart numbers begin with the number 005.  Locate the desired patient in the list by using the 

scroll bar to the right of the patient list box.  Click on a name to select the desired patient for 

printing, entering new information, or editing. 

 

Note:  To remove or change the filter, delete the number from the chart number box  

number and enter a new one or just delete the chart number and press Enter to return 

to a display of all patients for the selected clinic. 

 

Sort Patient List 
Headings at the top of the patient table facilitate quick searches by sorting on chart number, 

last name or first name.  Click on the sort heading at the top of the desired column to re-sort 

the list alphabetically by first or last name or numerically by chart number.  Find the desired 

patient using the scroll bar to the right of the patient list box and click to select the patient. 

 

All-Patient Search 
Finding a patient in a large, multi-clinic registry can be difficult.  An “All Clinic” search 

option displays a list of active patients in the registry for all clinics established in CDEMS.  

Because data cannot be entered or edited for inactive patients, the inactive patient list can 

only be viewed through the Edit tab > click Inactive button.  The filtering and sorting 

techniques just described can be used to narrow the All Patient search.  Keep in mind that 

it‟s possible for patients to exist in two or more clinics in CDEMS (e.g., a patient could be in 

both a Diabetes and an Asthma clinic at the same time if the registry is set up to track 

patients by condition).      

 

Fig. 21 - Find a Patient:  All Clinic Search 
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Print 

CDEMS automatically starts with the Print tab selected and the print-related buttons visible at 

the bottom of the screen.  Toward the top of the window note the Chart Number and Select 

Clinic text boxes.  These fields limit the patients displayed in the list to those with similar chart 

numbers and those from the selected clinic.  Print tab options include: 

 

 Preview – view the current Progress Note for a selected patient 

 Print – print the current Progress Note for a selected patient 

 MultiPrint – group individual charts for batch printing 

 New Patient Form – print a blank New Patient Form 

 
 Clinic and chart number must be entered in order to use the first two Print features.  

Selecting this information from the clinic and chart lists reduces typing time and ensures 

data consistency and accuracy.  Chart Number and Select Clinic text boxes are located 

towards the top of the opening window.  First, filter the patient list by selecting the 

desired clinic from the dropdown list if the desired patient is not listed in the default 

clinic list.  This selection limits the patients displayed to those within the specified 

clinic. 

   

Preview Progress Note 
1. Select patient from the patient list 

2. Click Preview to view the patient‟s current Progress Note 

3. The CDEMS Progress Note displays; click the middle button 

at the top of the form to maximize the window. 

4. Close the Progress Note by clicking on the inner “X” in the 

upper right corner of the screen.  The graphs page will now 

display if graphs are defined. 

Warning: Clicking the outermost ñXò at top of screen closes 

ACCESS and CDEMS.  Donôt worry, this happens routinely ï 

just re-open CDEMS and continue working. 

 

Print Progress Note 
1. Select patient from the patient list. 

2. Press Print to send the patient‟s last Progress Note directly to the printer. 

-or- 

1. Select patient from the patient list. 

2. Click Preview to view the Progress Note before printing 

3. Click File on the window menu bar 

4. Click Print in dropdown list > OK   

 

Maximize 

Minimiz
e 

Close form 

Close CDEMS 
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MultiPrint 
The MultiPrint feature enables batch 

printing of Progress Notes to speed up the 

printing process if you‟re sharing a printer 

or have a printer that slows down the 

process.  Use MultiPrint to batch print all or 

a selection of Progress Notes.   

 

The MultiPrint screen is shown in Fig. 22 

where patients are displayed descending 

order by last visit date (most recent visits at 

the top).  At the start of registry building, 

often there will be patients in the registry 

who have not had visits recorded; these 

patients will display at the bottom of the 

MultiPrint list. 

 

While the default sort order is by last visit 

date, the list can be sorted by chart number, 

last name, or first name.  Click on the 

column heading that matches the sort order you desire to rearrange the patient list for easier 

selection.  Print options include: 

 

 Print Selected – prints Progress Notes only for patients selected in the patient list.  Click 

on the first patient name.  Press and hold the ctrl key down while selecting additional 

patient Progress notes to print.  When all selections have been made, click Print Selected.  

 

 Print All – prints Progress Notes for ALL patients in the clinic even if a subset of 

patients has been selected.  Be careful here!  If you inadvertently click Print All, simply 

remove the paper from the printer paper tray and cancel the print job. 

 

Print Blank Data Collection Form  
1. Click New Patient Form 

2. A Data Collection Form 

can be created for the 

health condition(s) 

selected on the Print Data 

Collection Form screen 

(Fig. 23).  A blank 

abstraction form will be 

produced displaying the 

measurement set for the 

primary condition 

specified.  For a 

combination form, press 

the ctrl key while making 

multiple selections from 

the condition list. 

3. Click Print to preview, then print the data collection form for the specified conditions (see 

sample at Fig. 24). 

Fig. 23 ï Data Collection Form Options 

Fig 22 - MultiPrint Screen 
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The Data Collection Form is useful as (1) an abstraction tool for collecting initial patient data to 

enter for a primary chronic health condition, (2) as an intake sheet for new patients, and (3) as a 

visual aid in developing the setup for new conditions being tracked in the registry. 

   

Data Entry 

The Entry tab is where all 

data entry tasks are 

accomplished.  The Entry 

screen shown at Fig. 25 

contains two data entry 

functions: (1) Add New 

Patient, and (2) Add New 

Data.  New Patient 

demographic information is 

entered using the Add New 

Patient button.  New visits, 

health conditions, meds, 

labs/services, and custom 

notes are all entered using the 

Add New Data button.   

 

 

Fig. 25 ï CDEMS Opening Screen (Entry tab) 

Fig. 24 Data Collection Form for Diabetes 



v.0211  CDEMS Data Entry - 44 

There are two critical points to note about data entry: 

 

¶ A new patient must be added to the registry before health information can be 

entered. 

 

¶ A patient must have a health condition recorded in CDEMS before labs or service 

can be entered.  Labs and services are associated with a particular health condition.  

Without a health condition, the labs and services dropdown lists will be empty. 

   

Add New Patient 
A new patient record can be created with minimal info: chart number, clinic and start date.  

 

1. From the CDEMS Opening screen select the Entry tab > Add New Patient.  A blank Patient 

Info window (Fig. 26) appears on the screen. 

 

2. Clinic, Chart # and Start Date are the minimum required fields to create a new patient in 

CDEMS. 

 

Note:  CDEMS uses the start_date to evaluate patients who are active within the reporting 

time period. If the patient's start_date falls after the end_date in the period, they'll not be 

considered an active patient for summary reports. The start_date may be the date a patient 

record is first entered into the CDEMS registry or it could be the date a patient was first 

treated at your clinic.  How the start-date is defined really depends on how far back you 

intend to go for baseline reporting.  It‟s an individual clinic choice.  If a start_date is not 

entered, the default date is today‟s system generated date. 

 

 

3.  Click Create Record.  A new patient record is created in the CDEMS registry.  

 

To create a more detailed New Patient record, follow the data entry steps below.  Enter as much 

information as you have or desire to track in the patient record fields shown in Fig. 26.  

Fig. 26 - Patient Info Record 
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4. Add New Patient:  Name 

a) Start in the Last Name box; enter Last Name > Enter 

 TIP: The first letter of last name is automatically capitalized to speed data entry. 

b) Enter First Name > enter.  Again, the first letter is capitalized automatically. 

5. Add New Patient:  PCP 

a) Click on arrow in PCP box and select PCP from dropdown list 

 TIP:  The program will try to guess the PCP name if you type the first letter or two 

of the provider‟s name – i.e., if Smith, Andy is in the PCP list and you type an “S”, 

the program displays the first name beginning with an “S”.  

b) If the desired name is not in the dropdown list, type PCP name.  A message box 

appears: “PCP not on list.  Add to list? Y/N”.  Press OK to add to the PCP list.  The 

PCP is now permanently added to the CDEMS PCP table and will always appear in the 

dropdown list.  Be sure another variation of the provider name does not already exist in 

the list before adding a new provider. 

6. Add New Patient:  Other Fields 

Continue entering information in every field where data is available. 

a) Enter Address1, Address2 (optional), City, State (default=WA), ZipCode, Phone1, 

Phone2 > press enter or tab after each field to advance to start of the next field. 

 TIP:  Formatting is automatic for zip code and phone numbers; enter only numbers 

b) Click M or F button near the Sex label (default is U = unknown) 

c) Enter mmddyyyy in the DOB field.  DOB is the only date field in CDEMS that requires 

a 4-digit year. 

 TIP:  Date separators are automatic. 

d) Click Ethnicity box dropdown arrow and select from list, or type first letter of ethnic 

group (i.e., w=white, h=Hispanic…) 

Note:  A new ethnic group can be added by simply typing in a new ethnicity.  A message 

will appear: “Ethnic Group not on list.  Add?”  Click OK to permanently add this name 

to the ethnicity list. 

e) Click Primary Language box arrow and select from dropdown list -or- enter first letter 

of the primary language (i.e. e=English, s=Spanish…) 

Note:  A new language can be added by simply typing in the language name.  A message 

will appear: “Primary Language not on list.  Add?”  Click OK to permanently add to the 

language list. 

f) Click Insurance Co. box arrow and select from dropdown list -or- type first letter or two 

of payer name 

Note:  New insurance payers can be added by typing in the payer name.  A message will 

appear: “Insurance name not on list.  Add?”  Click OK to add.  Another message 

appears: “Enter the NUMBER best corresponding to the category for this insurance 

1=commercial, 2=medicaid, 3=medicare, 4=unknown”.  Enter appropriate number > OK 

to permanently add this insurance company to the list 

g) Click the appropriate button Y/N for Migrant status (default is U=unknown) 

h) Click the appropriate button Y/N for Homeless status (default is U=unknown) 
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i) Enter new patient Start Date mm/dd/yy 

Note:  CDEMS uses the start_date to evaluate patients who are active in the registry 

within a reporting time period. If the patient's start_date falls after the end_date in the 

period, they'll not be included as an active patient in summary reports. The Start Date 

may be the date a patient record is first entered into the CDEMS registry or it could be 

the date care for the patient started at your clinic.  How the start-date is defined really 

depends on how far back you‟ll want to go for baseline reporting.  If a start_date is not 

entered, the default date is today‟s system generated date. 

j) Click Create Record to create and save the new patient record. 

 

Enter Patient Health Information 
A patient record must be created before data about health conditions, meds, services/labs or new 

visits can be entered.  Once demographics are entered and the patient is active in the registry, 

select a patient from the list on the CDEMS opening screen > click on Entry tab > Add New 

Data.  The New Visit form appears with the selected patient name and chart number visible in 

the Visit section of the form as illustrated in Fig. 26.   

 

 

Five types of information can be entered in any sequence on the New Visit form:  
 

 Visit 

 Health Conditions 

 Meds 

 Services/Labs 

 Custom 

 

1. Visit Data 

At a minimum, the Visit Date must be entered to create a new visit record.  Other types of 

visit information include type of visit, vital statistics such as weight, height, and blood 

pressure, and next visit date.  Click Create to record and save visit data. 

Note:  If a value is unknown for any field, it‟s best to leave the field empty.  A common error 

Fig. 26 - New Visit Form 
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occurs when a “0” is entered for an unknown height.  The program uses height as the 

denominator for calculating BMI, and, a zero divisor causes a fatal error in the program. 

 

2. Health Condition Data 

 

Add a health condition – Enter first the diagnosis date for the health condition in the health 

condition Start box.  Select a condition to add from the All Dx list in the right-hand column, 

then click the left arrow (<) – or double-click -- to include the condition in the Pat. Dx box.  

A message appears “Do you want to add the condition starting on mm/dd/yy?”  Enter yes to 

record the condition.  The start date should be the actual diagnosis date or as close to it as is 

possible.  If only the year of diagnosis (or earliest treatment date) is known, substitute “01” 

values for the unknowns (e.g. 01/01/89 signifies that the condition was likely diagnosed 

sometime in 1989).  Start_dates can be modified later in Edit mode when more accurate 

information becomes available.  The health condition end date on the data entry screen is 

used only when the condition is ended. 

 

 TIP:  A health condition must be recorded before services and labs can be entered.  

CDEMS displays associated labs and service dropdown lists based on the primary 

health condition.  Without a health condition, there are no dropdown lists to 

display. 

 

Discontinue a health condition – Enter the end date for the health condition, then select the 

condition to discontinue from the Pat Dx list in the left column.  Click the right arrow (>) to 

remove the condition from the Pat Dx list.  A message appears “An OK will retain this 

record in the database stored with an end date of mm/dd/yy.”  Enter OK. 

 

Delete a health condition – Select the condition in the Pat Dx list in the left-hand column 

and click the “X” between the two columns to delete a health condition.  This action deletes 

a previously entered condition from the patient‟s record without archiving the information.  

This function is used to remove a health condition that was erroneously entered for the 

patient. 

 

3. Meds Data 

Med choices are displayed in the All Rx list. 

 

Add a Med - Enter first the start date for the med in the Meds start box.  Meds are added by 

selecting from the All Rx list in the right-hand column and clicking the left arrow (<) to 

include the med in the Pat Rx list in the left column.  A message appears “Do you want to 

add the med starting on mm/dd/yy?”  Enter Yes to record the med.  The end date for a med 

on the data entry screen is used only when the med is discontinued. 

 

 TIP:  If only a partial date is known for the start of a med, use the best information 

available and fill in unknowns with “01” values.  For example, if only month and 

year of the med start date is known use “01” as the value for the missing day (enter 

03/01/98 to record a med started in March 1998).  Corrections can always be made 

through the Edit screen if more accurate dates become available.   
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Discontinue a Med - Enter first the end date for the med, then select the med to discontinue 

from the Pat Rx list in the left column.  Click the right arrow (>) to remove the med from the 

patient Rx list.  A message appears “An OK will retain this record in the database stored with 

an end date of mm/dd/yy”.  Enter OK. 

 

Delete a med – Erroneously entered medications may be deleted by selecting from the Pat Rx 

list in the left column and clicking the X between the two columns.  This action deletes the 

med from the record and does not archive information. 

 

4. Services/Labs Data 

The Services and Labs displayed in the All Services and All Labs lists are those associated 

with the patient‟s diagnosed health conditions.  Services and labs are entered by selecting 

from the dropdown list and adding a date.  Results, if appropriate, are also entered at this 

time.  Select a status flag from the dropdown list to make an entry other than “c” (completed) 

in the Status box field.  An “r” status flag indicates the lab or service was referred; “d” 

documents that the patient declined the lab or service. 

 

The hard-coded Diabetes Summary report in the past required very specific entries for 

Exercise Assessment, Smoke Assessment and Smoke Cessation services.  Exercise 

assessment required a numeric result entry (0-7) representing the number of days/week the 

patient exercised.  Only “current”, “past”, or “never” Smoke Assessment results were used to 

evaluate smokers in the Diabetes Summary Report.   

 

Create-a-Report and Create-a-List templates in the CDEMS reports program permit 

customization of service results.  As long as a consistent scheme is developed and used for 

recording results, the user-defined report templates can produce summary reports and lists 

based on your specific entries.  For example, an exercise assessment could be recorded as 

“None”, “Moderate”, “Active”; diabetes education classes could be recorded as a DM Educ 

service with a result of Class1, Class2, Class3, or Group1, Group2… to represent specific 

diabetes education classes attended.  They key is to record the results entries consistently for 

later evaluation.   

 

 TIP:  It‟s still best to stick with the “current”, “past”, or “never” Smoke Assessment 

results because of special measures queries in the Reports program that rely on 

these designations to calculate the total smoker count.  

Edit 

If people never made errors in keying data into CDEMS and patients never moved or changed 

their last names, an edit function might not be necessary.  But for these and various other 

reasons, the Edit feature is available to modify visit information, meds/conditions, services/labs, 

and patient info.  Use the same 3-step procedure to begin an edit of any these sections:  

 

1. Select the Edit tab from the CDEMS Opening Screen 

2. Select a clinic from the clinic dropdown list 

3. Click on the desired patient name in the list to select a record for editing.  Note that Active 

or Inactive patients can be selected for editing by clicking the appropriate button on the right 

side of the window (see Fig. 27).   
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Edit Visits or Notes 
 

1. Click Edit Visits or Notes on 

the Edit tab from the CDEMS 

Opening Screen.  Two boxes 

open simultaneously with Edit 

Notes overlaying the Edit 

Visits screen (see Fig. 28). 

 

2. Verify the patient is the one 

you want to edit. 

 

3. Toggle back and forth 

between the Edit Notes and 

Edit Visits windows by 

clicking anywhere on the 

visible part of the desired 

window.  This will bring that 

window to the foreground on 

your screen.  Either window 

may be closed by clicking on 

the X in the upper right 

corner. 

 

4. Scroll through Notes or Visit 

records by clicking the record 

arrows at the bottom of the 

window until you reach the desired Note or Visit date to edit. 

 

Fig. 27 - Opening Screen (Edit Mode) 

Active & 
Inactive 
List Filter 

Fig. 28 - Edit Visits & Notes Data 

 

Record # 
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5. Edit a Note or Visit by typing corrections to the date or data in the desired record.  Delete a 

Note by clicking on Edit (in Access menu bar at the top of your screen) > Delete Record.  

Double-check that you are about to delete the desired record before confirming that you want 

to permanently delete the record.  WARNING:  DELETIONS ARE IMMEDIATE AND 

CANNOT BE UNDONE! 

 

6. Click on “X” in upper right corner of the form to exit. 

 

Edit Meds or Health Conditions 
 

1. Click Edit Meds or 

Conditions on the Edit 

Tab from the CDEMS 

Opening Screen.  Two 

forms open 

simultaneously with 

Edits Meds overlaying 

the Edit Health window 

(Fig. 29).  

 

2. Confirm the patient is 

the one for which you 

want to edit meds or 

health conditions. 

 

3. Toggle back and forth 

between the Edit Meds 

and Edit Health 

windows by clicking 

anywhere on the visible 

part of the desired window.  This will bring that window to the foreground on your screen.  

Either window may be closed by clicking on the “X” in the upper right corner. 

 

4. Edit a Med or Health Condition by typing corrections to the date or data in the desired 

record.  Delete a record by clicking the gray cell at far left of row to eliminate; then click 

Edit (in Access menu bar at the top of your screen) > Delete Record.  Double-check that you 

are about to delete the desired record before confirming that you want to permanently delete 

it.  WARNING:  DELETIONS ARE IMMEDIATE AND CANNOT BE UNDONE! 

 

5. Click on “X” in upper-right-hand corner of the form to exit. 

 

Fig. 29 - Edit Meds & Health Data 

Record # 
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Edit Labs or Services 
 

1. Click Edit Labs or 

Services on the Edit tab 

in the CDEMS Opening 

Screen.  Fig. 30 shows 

the two forms opened 

simultaneously with 

Edits Labs layered over 

Edit Services. 

   

2. Verify the patient is the 

one for which you want 

to edit labs and/or 

services. 

 

3. Toggle back and forth 

between the Edit Labs 

and Edit Services 

windows by clicking 

anywhere on the visible 

part of the desired 

window.  This will bring that window to the foreground on your screen.  Either window may 

be closed by clicking on the “X” in the upper right corner. 

 

4. Edit Lab or Service data by typing corrections to the desired lab or service entry.  Delete a 

record by clicking the gray cell at far left for row to eliminate; then click Edit (in Access 

menu bar at the top of your screen) > Delete Record.  Double-check that you are about to 

delete the desired record before confirming the deletion. WARNING:  DELETIONS ARE 

IMMEDIATE AND CANNOT BE UNDONE! 

 

5. Click the “X” in upper-right-hand corner of the form to exit. 

 

Edit Patient Information 

 
1. Click Edit Patient Info on the Edit tab from the CDEMS Opening Screen.  The Patient Info 

window appears as shown at Fig. 27. 

 

Fig. 30 - Edit Labs & Services Data 

Record # 
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2. First, verify the patient is the one for which you want to edit.  

3. To modify a record, simply type corrections > click Create Record to save changes. 

 

Inactivate a Patient 

 
When patients become inactive due to a move, death, provider change, etc., their status is easily 

changed in the registry by entering a date in the inactive date cell reflecting when the patient 

became inactive.  With a date in the inactive date field, the patient is assigned an “inactive 

status,” and all patient records are retained in the database.  Information about this patient is 

included in clinic summary totals or intervention reports if the time they were active falls within 

the time period of the report. While new information cannot be entered for an Inactive patient, 

prior info may be edited by clicking the “Inactive” button in the Edit module and selecting the 

clinic and desired patient from the list. 

 

 TIP:  For a patient who has not been actively treated at the clinic for some time, 

recording an inactive date just after the patient‟s last active date (last visit or last lab 

date) will remove them earlier, and more accurately, from inclusion in current reports.  

For example, a patient whose last visit was 06/01/05 would be excluded from current 

reports with an inactive date of 06/02/05. 

 

 TIP:  Record a short note in the “Other” field to document the reason for inactivation – 

e.g. “moved,” “changed health care provider,” “deceased,” “unable to contact”.   

   

Reactivate a Patient 
 

An inactive patient is made active again by simply removing the inactive date in the Edit Patient 

Info screen.  All previous records are restored to the active database.  Remember to remove notes 

from the “Other” field documenting the reason for Inactive status. 

 

Inactive 

Date Field 

Fig. 27 ï Edit Patient Info Screen 

Inactivate 
Date Field 
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Delete a Patient 
 

Usually a patient is deleted from the registry if a duplicate record was created erroneously.  Be 

sure to merge data for duplicate patients into a single record before deleting one of the 

duplicates.  Otherwise, it‟s always better to make a patient inactive and retain all data in the 

registry.   

 

1. To delete a patient record, click the Delete Patient button in the lower right corner of the 

window.  The demographic record and ALL related visits, conditions, med, services, and lab 

records for this patient will be deleted forever.  A warning message will alert that the record 

is about to be permanently deleted.  DELETIONS CANNOT BE UNDONE!  Confirm with 

an OK if you are certain about permanently deleting a patient record.  

 

2. The Patient Info form automatically saves and closes after completing a Create Record or 

Delete Patient function. 

 

3. Click Cancel to exit the screen without making changes 
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TECHNICAL SUPPORT 

 

Resources & info at www.cdems.com 

 
 Download Current Programs 

¶ Data Entry 6-7-10  

¶ Reports 7-30-10 

¶ PowerTools_4-22-05 (Grouper & Logger) 

¶ Electronic Lab Interfaces 

¶ Customized versions of CDEMS programs shared by other users 

 

 Program Documentation 

¶ CDEMS Data Entry Guide 

¶ CDEMS Reports Guide 

¶ CDEMS Electronic Lab Interface Guide  

¶ PowerTools/Grouper Guide 

¶ Advanced Query Guide (“The Joy of Querying”)  

 

 User Forum Discussion Topics 

¶ Installation & Setup 

¶ Access 2007/2010 issues 

¶ Data issues 

¶ Print issues 

¶ Tickler 

¶ Reports 

¶ Custom Queries 

¶ Other 

¶ CDEMS-EMR Integration 

¶ Electronic Lab Interface 

 

 Training Information 

¶ Regular Data Entry & Reports webinars 

¶ Monthly national user meeting teleconferences 

 

 Staying up-to-date 

¶ e-mail distribution list (contact jackie@cdems.com to add your name) 

 

 Tech Support 

¶ Contact:  jackie@cdems.com 

¶ WA users toll-free support line:  1-800-478-3563 

¶ National users support line:  916-817-1401 

¶ Fee-based support options:  www.support.cdems.com 

http://www.cdems.com/
mailto:jackie@cdems.com
mailto:dems.cdems@verizon.net
http://www.support.cdems.com/

